
 

 

Detailing in Autodesk® Revit® Architecture 
Paul F. Aubin – Paul F. Aubin Consulting Services 

AB3744 Part of creating a successful building information model is knowing what to build into the 
model and what to leave out of the model. When learning Revit, many users have a tendency to “over 
model.” What is often not clear, is that Revit offers a powerful suite of detailing tools. This class will 
explore the process of extracting views from your model and then detailing them within Revit. You will 
learn about model views and drafting views. You will gain understanding on when to model, when to 
draft, and when to import graphics from other CAD programs. We will cover detail components, drafting 
elements, symbolic lines, text, annotation and keynotes. If you have been told the myth that you can’t do 
construction documents in Revit Architecture, then join us in this session of “myth busting” as we explore 
the complete detailing process in Revit Architecture. 

Learning Objectives 
At the end of this class, you will be able to: 

• Learn the Revit detailing process from top to bottom  
• Understand "Hybrid" details and how to create them  
• Learn when to stop modeling and when to start detailing  
• Let's not forget "typical" details and details imported from CAD 

 

About the Speakers 
Paul F. Aubin is the author of many CAD and BIM book titles including the widely acclaimed: 
The Aubin Academy Mastering Series: Revit Architecture, AutoCAD Architecture, AutoCAD 
MEP and Revit MEP titles. Paul has also authored video training both on his Web site and for 
lynda.com www.lynda.com/paulaubin. Paul is an independent architectural consultant who 
travels internationally providing Revit® Architecture and AutoCAD® Architecture 
implementation, training, and support services. Paul’s involvement in the architectural 
profession spans over 20 years, with experience that includes design, production, CAD 
management, mentoring, coaching, and training. He currently serves as Moderator for Cadalyst 
magazine’s online CAD Questions forum, is an active member of the Autodesk user 
community, and has been a top-rated speaker at Autodesk University (Autodesk’s annual user 
convention) for many years. This year Paul is speaking at the Revit Technology Conference in 
both the US and Australia. His diverse experience in architectural firms, as a CAD manager, 
and as an educator gives his writing and his classroom instruction a fresh and credible focus. 
Paul is an associate member of the American Institute of Architects. He lives in Chicago with 
his wife and three children. You can reach Paul at: www.paulaubin.com (click the contact link). 
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Introduction 
Creating detail drawings in Revit Architecture involves a combination of live 
views generated from the building model and overlaid two-dimensional 
embellishments and notes. The process is simple—create a callout or 
section view of the model at a large scale and then add additional 
drafted components, text, dimensions and other embellishments 
necessary to craft the detail and convey design intent. In most cases, 
such embellishments are drawn relative to an underlying building 
model view and can be automatically constrained or linked to model 
geometry in the view. Unlike the other Revit Architecture views, 
all Drafting Components appear only in the view to which 
they are added.  

A large collection of Detail Component Families is included 
with the software and using the provided Family Templates, you can create additional detail 
components as required. In addition to detail component Families, drafting lines, batt insulation, 
filled regions and repeating details will help to flesh out the details you create.  

Building Information Modeling and Detailing 
If you have been using Revit Architecture for a while but are new to its detailing capabilities, you 
are likely to have the 
expectation that to create a 
detail, one simply cuts a 
section of the appropriate 
area of the model and open 
the resulting view to see an 
automatically generated 
detail direct from the 
Building Information Model! 
Alas, this is only partially 
true. The reality is that it is 
a rare instance when all of 
the specific components 
required by a successful 
construction detail can be 
effectively modeled in all 
aspects and thus “built into” 
the overall building model. 
In most cases, the effort 
required to model the small 
scale components shown in the typical construction detail would prove impractical and would 
generate a very large and unwieldy model. Therefore, while theoretically a fully embellished and 

 
Figure 1 – Revit Architecture’s Hybrid approach to detailing – 
Image courtesy of Robert Guarcello Mencarini, Architect, AIA (2D 
Detail Components are shaded blue in the figure) 
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detailed building model capable of generating all large scale views and details is seen by some 
as the ultimate goal, currently (and perhaps indefinitely) the means to do so do not justify the 
end.  

To keep the size of our models reasonable and to avoid spending additional and often 
unnecessary effort modeling every bolt screw and piece of flashing, the strategy to detailing in 
Revit Architecture is instead a hybrid approach. In nearly all details you may endeavor to create 
in Revit Architecture, you will be able to start the process with a cut from the model. This live 
view of the model portrayed at the scale of the detail, will give you a starting point upon which to 
add detail components and other view specific elements and annotations. By separating a detail 
into both live model elements and view-specific embellishments, we achieve the best of both 
worlds: we have an underlay that remains live and changes automatically with the overall 
building model and we have all of the additional data required to convey design intent occurring 
only on the specific detail view, thus saving on overhead and unnecessary modeling effort.  

As you can see in the illustration in Figure 1, there are many tools at our disposal that when 
used together give us a complete detailing solution. The next several topics will introduce many 
of these tools.  

Detail Callouts 
You can create the detail view from a portion of your model using the Callout tools. Callouts can 
be made from plan, section or elevation views. Creating an enlarged scale callout is typically the 
first step in the detailing process.  

 
Figure 2 – You can make callouts of any other view 

Detailing Tools 
Once you have created your callout or section, you will find the tools you need to embellish it on 
the Annotate tab of the ribbon. Refer to this illustration and the following descriptions. We will 
start with the tools on the Detail panel.  
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Detail Lines—The most straightforward form of embellishment is drafted Linework (lines, arcs, 
circles, etc) that can be used for any generic illustration purposes. Detail Lines have all of the 
same options as Model Lines. However, Model Lines appear in all views like other model 
geometry and Detail Lines appear only in the view in which they are sketched. Use Model Lines 
for items like Control Joints on elevations and Detail Lines for items like flashing in construction 
details.  

 
Figure 3 – Detail Lines used to draw flashing in the masonry cavity 

Filled Regions—These are polygon objects that are drawn like other Revit 
sketch-based objects. Filled Regions include an edge style and a fill pattern. 
Use them to add graphical embellishment representing materials that would be 
impractical to model three-dimensionally. 

 
Figure 4 – Using a Filled Region to show materials that would be impractical to model 

Masking Regions—These are polygon objects that are drawn like other Revit sketch-based 
objects. Masking Regions include an edge style and a solid white fill. They are nearly identical 
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to Filled Regions except that instead of a pattern they have a simple white fill. When exported to 
AutoCAD, Masking Regions will not appear solid black as Filled Regions with white fills do. Use 
them to “white out” areas of the model that you do not want displayed in the detail. 

Detail Component—Similar to the Component tool on the Home tab of the ribbon, this tool 
inserts a Detail Component Family. A Detail Component is a 2D Family that represents some 
common element in a construction detail such as a piece of wood blocking, or an anchor bolt or 
a steel shape. Like other Families, most Detail Components have several Types from which to 
choose each representing a particular size or configuration of an element. For example, the 
Nominal Cut Lumber-Section Detail Component Family includes sizes like 2 x 4, 2 x 6 and 2 x 
10. Unlike Model Component Families, they are inserted only into the current view and sit 
graphically on top of any model geometry. 

 

Figure 5 – Browsing for Detail Components in the out-of-the-box library 

In some cases, a Family will have an associated Type Catalog. You will see this when loading a 
new Family into your project. Simply load the Family as normal. After you select it and click 
Open, a separate dialog will appear with a table of available sizes for the Family or Families 
selected. When a type catalog is 
available, you can select one or more 
sizes using the SHIFT and CTRL keys and 
then import them into your project when 
you click OK.  

Repeating Detail—This tool is used to 
place linear arrays of other Detail 
Components. Find it on the Component 

Browsing in Windows Explorer 
Tip: By default the Detail Component Library is 
saved in the All Users folder (Windows XP) or the 
Program Data folder (Vista and Windows 7). You 
can browse to the components via Windows 
Explorer and then drag the desired Family file and 
drop it into the Revit Architecture project window. 
This will import the Family and all of its Types.  
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drop-down button. For example, to place an array of bricks in a detail, you define a Repeating 
Detail that contains a brick Detail Component and repeats it every 2 2/3". Repeating Details can 
be used to add floor joist, brick joints, masonry ties, control joints, Ceiling tiles, etc.  

 
Figure 6 – Repeating Detail to show floor joists in the floor cavity 

Revision Cloud—Sketch based object used to enclose areas of the drawings that have been 
modified since the last document issue. There is also a Revision Tag that ties the revision 
clouds to entries on a revision schedule built into the titleblock.  

Symbol—This tool places a Generic Annotation Family in the current view. You must have the 
desired Generic Annotation Family loaded in your project, or you can use the Load Family 
button to locate one and import it. You can schedule Generic Annotation Families using a Note 
Block Schedule.  

Detail Group—This tool will let you insert a Detail Group into the current view. A Detail Group 
contains a named collection of detail (view-specific) elements. Similar to a Model Group, if the 
Detail Group is edited, all instances of it throughout the project will update.  

Insulation—This tool creates a special kind of Detail Line in the form of batt insulation. Use this 
to add insulation in your details.  

Additional Detailing Tools 
In addition to the ribbon tools noted above, there are other tools and techniques useful to 
detailing.  

Lock Components—As you add components in a Revit Architecture project, you have no 
doubt discovered that you can often click the small padlock symbol to constrain the position of 
one element relative to another. This can be very handy in many instances to help maintain 
desired design relationships as the project progresses. When you are adding detail 
components, it is possible to lock these to the underlying model geometry. In this way, if the 
elements in the model move, the detail components associated with them will stay attached 
even though they appear in only their own callout or section view. Use caution when employing 
this technique however. In some cases the extra effort required to align and lock detail 
components can outweigh the benefit of having them locked. If the design changes you 
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anticipate are limited to the movement of a Wall or Floor, it may be easier to simply open the 
detail view later and move the detail components manually to the new position. This can also 
help you avoid those frustrating “Constraints not satisfied” error messages.  

 
Figure 7 – You can optionally lock detail components to the underlying model geometry 

Show/Remove Hidden Line—When a Filled Region or other Detail Component conceals 
another component or model element, it is sometimes desirable to have the edges of the 
concealed element show through as a dashed line. This tool will create this condition for you. 
Click the View tab of the ribbon and find the Show Hidden Lines tool on the Graphics panel. 

 
Figure 8 – Show Hidden Lines displays concealed objects as dashed lines 

Use Remove Hidden Lines tool to reverse the effect.  

Cut Profile—Also on the Graphics panel, this tool gives us the ability to edit the shape of the 
heavy cut line that Revit automatically generates when an object is cut in section or plan. This 
type of edit is view-specific and two-dimensional. While it does not change the 3D shape of the 
model, it gives us a quick way to make the detail look the way we need without forcing us to 
model something that would have little or no benefit in other views. For example, something like 
a key between the bottom of a foundation wall and the top of a footing, that would never be 
seen in any view other than a section or detail view, it would be difficult to justify the additional 
time or effort required to model it in 3D. Using the Edit Cut Profile tool we can make the section 
or detail appear as required without the extra modeling overhead. 
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Figure 9 – Use Edit Cut Profile to modify the automatically generated profile outline 

Keynotes 
While much of creating a detail involves the drawing itself, equally critical is the notes and 
annotations used to describe its contents. Keynoting allows you to annotate your details (and 
other views) using a pre-defined list of notes. The notes are organized in a keyed list, which is 
why they are referred to as keynotes. However, it is not required that you actually utilize the 
keys in order to use the keynote functionality. Revit Architecture includes a sample keynote file 
organized in CSI format. You can use this list as is, edit it or create your own. Creating or editing 
your own file is easy. The Keynote list is stored in a simple tab-delimited text file. If you wish to 
create your own file, search for the “Sample User Keynote Text File” topic in the online help for 
instructions and an example of the proper format.  

Keynote Settings—Before you can keynote elements in your project, you must load a Keynote 
file. On the Annotate tab, click on the Tag panel title (this is an expandable panel and will pop 
open), click the Keynote Settings tool. 

 
Figure 10 – Load a Keynote file and Configure settings in the Keynote Settings dialog 

Use the Browse button to load an existing file. You can use the provided file or create your own 
as noted above. Three types of path are possible. An Absolute path writes the complete path 
back to the drive letter. A Relative path assumes that the keynote file is located in the same 
location as the project file and therefore only writes the path relative to the location in which the 
project is saved. Using the “At Library Locations” option writes the path relative the locations 
defined on the “File Locations” tab of the Options dialog (Application menu). Click the File 
Locations tab and then click the Places button to see and edit the library locations.  

Keynotes can be numbered using the keynote defined in the file or by sequential number 
relative to each Sheet in your document set. In other words, the “By keynote” method will use a 
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fixed and predefined key (in the keynote file). The “By sheet” method will compile the numbering 
uniquely for each Sheet of the set.  

Keynote Tags—Keynote tags are added by selecting elements in the model. If a Keynote is 
already assigned to the selected element, the tag will simply appear on screen. If the keynote 
has not yet been assigned to the selected element, a dialog showing the list of keynotes in the 
file will appear. Choose an appropriate note and then click OK. The out-of-the-box Keynote tag 
has three Types that give you the flexibility to show the key or the note itself. If you wish to see 
both the key and the note text, you can edit the Family and add a Type for this.  

 
Figure 11 – Swap the Keynote tag to show the desired type 

Types of Keynotes—Keynotes have three modes: Element, Material and User. The Element 
option reads the keynote assigned to the element in the model such as the keynote assigned to 
a Wall or Door, not the individual layers or sub-components of the Wall or Door. To keynote the 

layers of a Wall or components of a Door, you would use the Material keynote 
option. This will read the keynote assigned to the Material of the selected 
component. When you wish to override the pre-defined keynote setting, choose 
the User option. This option will display the “Keynotes” dialog and prompt you to 
choose a note of your choice. Since this option is an override, it will not update if 
you edit the Type or Material of the selected element.  
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Figure 12 – Assign Keynotes to the Element Type or the Material or both 

Keynotes unfortunately have a few limitations. For example, certain items cannot be keynoted 
like Repeating Details and Batt Insulation. The reasons for this are not exactly clear. 
Furthermore, keynotes have not been pre-assigned to the out-of-the-box content. This means 
that a great deal of effort will need to be expended to go through the library and assign keynotes 
to both Families and Materials. While you might be tempted to abandon the keynote 
functionality altogether based on these limitations, it is recommended that you try using them in 
production despite this. Once set up, having keynotes assigned to elements will save a great 
deal of time in production and will help to standardize the verbiage used on notes throughout 
the office.  

Importing Details 
Most architectural firms have amassed a library of “standard” details over the years. Such 
standard details may be drafted manually or generated in other computer drafted programs like 
AutoCAD. As you transition your day-to-day operations over to Revit Architecture you do not 
have to start completely over with such resources. Over time you may choose to redraw your 
standard library natively in Revit Architecture, but in the meantime, you can import both scanned 
image files (from hand-drafted details) and popular CAD formats such as DWG, DGN and even 
SketchUp files.  

Before importing a file, on the View tab, on the Create panel, click the Drafting View button to 
create blank view in which to import it. A Drafting view is a blank sheet of paper with no link to 
the live Revit model. Use them to sketch or import details that are not cut from the model. Type 
a name and choose a scale when prompted.  



Detailing in Autodesk® Revit® Architecture 

11 
 

 

Figure 13 – Create a new Drafting View and assign it a scale 

The commands to import or link CAD files are located on the Insert tab of the ribbon. If you want 
to simply insert the CAD file, on the Insert tab, click the Import CAD button. This will import the 
CAD file into Revit without maintaining a connection back to the original file. If you wish to 
maintain a link to the file, so that you can later update it if the original changes, then click the 
Link CAD button instead. You can update the link periodically using the Manage Links button 
on the Link panel. 

 
Figure 14 – Import CAD Formats dialog from the Insert ribbon tab 

Browse to the file you wish to link (or import) and select it. Before clicking the Open button, 
configure the options at the bottom of the dialog. From the “Colors” list, you can keep the 
original CAD file colors, invert them or make everything black and white. In the “Positioning” 
area are several choices. For detail drawings, the “Manually place” option with either the 
“Manual – Base Point” or “Manual - Center” option typically will give the best results. In most 
cases, Revit will interpret the units of the imported file correctly; however, you can choose the 
import units manually from the “Import units” list. The “Layers” list defaults to importing all the 
CAD file layers, but you can also import a sub-set of layers with the “visible” and “specify” 
options.  

CAD files will come in correctly scaled based upon how they were created and the settings you 
chose for scaling in the “Import/Link” dialog. When you import a file, the layers will be 
maintained and accessible from the view’s Visibility/Graphic Overrides (keyboard shortcut VG) 
dialog on the Imported Categories tab.  
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Figure 15 – CAD Layers remain accessible via the view’s Visibility/Graphic Overrides 

Using this dialog, you can turn layers on or off and override their imported color or lineweight 
settings. Furthermore, if you select the import object on screen, on the ribbon you have the 
ability to delete layers, explode and query the objects within the import. Deleting layers will 
delete the layer and all objects on the layer within the imported file.  

 
Figure 16 – Options for a selected Imported CAD file 

When you explode an imported file, Line Styles will be added to your list of Line Styles (Settings 
menu). You will get a new Line Style for each layer in the imported file. The Detail lines 
generated from the exploded file will use these new line styles. In general, it is a better not to 
explode imported CAD files. Doing so litters your Revit model with many artifacts and often 
creates inaccuracies and other errors in the Revit file. For best results, clean up the file as much 
as possible in the original CAD program before importing into Revit and do not explode it.  

In addition to the Import and Link CAD buttons, you will also find an Image button. Click this 
button to import an image file in BMP, JPG, JPEG, PNG or TIF format into the current view. 
Imported Images will have shape handles on the corners that you can use to resize the image. 
You cannot automatically scale such images. Images appear only in the current view. You can 
drag such views to Sheets for plotting with the rest of your document set.  

Controlling Lineweights of Imported CAD Files 
When you import details or other files from AutoCAD or other CAD files, you can control the way 
that the lineweights of the imported Linework will be interpreted when it comes into Revit 
Architecture. On the Insert tab of the ribbon, on the right corner of the Import panel titlebar, click 
the dialog launcher icon.  
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Figure 17 – Configure how Revit should apply lineweights to the imported elements 

In the dialog that appears, you can Load a mapping file (several are included with the software), 
or input the desired values for each of the 255 possible imported color numbers. Since many 
existing CAD drawings use colors to determine what their lineweight is when plotting, Revit can 
assign its lineweights to the imported elements based on the values input in this table. If your 
imported entities use the lineweight property rather than color, the settings in this dialog will be 
ignored and the assigned lineweight used instead.  

If you have access to AutoCAD (or other CAD program), it is best to open the files and clean 
them up in their original environment first. Be sure that each detail uses consistent colors and 
lineweight settings so that you get predictable import results. Delete any unwanted geometry 
and purge unneeded layers and settings. If you need to use the same mapping settings for 
many files, click the Save As button to save the settings to a file for later retrieval.  

Manually Assigning Callouts to Drafting Views 
If you have chosen to import CAD details or if you have drawn them from scratch in Revit 
Architecture using only detail components (without an underlain live building model view), you 
can create callout symbols and manually assign them to the appropriate drafting views.  
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Figure 18 – Choose “Reference other view” to “point” a Callout to a Drafting view 

This is simple to do. Just check the “Reference other view” box on the Options Bar before 
drawing the Callout or Section. When you drag the Detail view to a Sheet, it will update the 
Callout appropriately.  

Further Study 
You can find more information and tutorials in The Aubin Academy Master Series: Revit 
Architecture. Chapter 11 is devoted to detailing and annotation.  

      

I also have Revit video training available on my website and at www.lynda.com/trial/paubin.  

If you have any questions about this session or Revit in general, you can use the 
contact form at www.paulaubin.com to send me an email.  

 Thank you for attending.  
Please fill out your evaluation.  

http://paulaubin.com/books/the-aubin-academy-master-series-revit-architecture-2012/�
http://paulaubin.com/books/the-aubin-academy-master-series-revit-architecture-2012/�
http://www.lynda.com/trial/paubin�
http://www.paulaubin.com/�

	Learning Objectives
	About the Speakers
	Introduction
	Building Information Modeling and Detailing
	Figure 1 – Revit Architecture’s Hybrid approach to detailing – Image courtesy of Robert Guarcello Mencarini, Architect, AIA (2D Detail Components are shaded blue in the figure)
	Detail Callouts
	Figure 2 – You can make callouts of any other view
	Detailing Tools
	/Figure 3 – Detail Lines used to draw flashing in the masonry cavity
	Figure 4 – Using a Filled Region to show materials that would be impractical to model
	Figure 5 – Browsing for Detail Components in the out-of-the-box library
	Figure 6 – Repeating Detail to show floor joists in the floor cavity
	Additional Detailing Tools
	Figure 7 – You can optionally lock detail components to the underlying model geometry
	Figure 8 – Show Hidden Lines displays concealed objects as dashed lines
	Figure 9 – Use Edit Cut Profile to modify the automatically generated profile outline
	Keynotes
	Figure 10 – Load a Keynote file and Configure settings in the Keynote Settings dialog
	Figure 11 – Swap the Keynote tag to show the desired type
	Figure 12 – Assign Keynotes to the Element Type or the Material or both
	Importing Details
	Figure 13 – Create a new Drafting View and assign it a scale
	Figure 14 – Import CAD Formats dialog from the Insert ribbon tab
	Figure 15 – CAD Layers remain accessible via the view’s Visibility/Graphic Overrides
	Figure 16 – Options for a selected Imported CAD file
	Controlling Lineweights of Imported CAD Files
	Figure 17 – Configure how Revit should apply lineweights to the imported elements
	Manually Assigning Callouts to Drafting Views
	Figure 18 – Choose “Reference other view” to “point” a Callout to a Drafting view
	Further Study

